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About This Manual

TouchWare is compatible with all Macintosh applications, making it ideal for
a variety of situations, including point-of-sale, training systems, information
and self-service kiosks, factory automation and process control, laboratory
and medical instrumentation, interactive selling demonstrations, and
educational programs.

This manual describes how to

Install and calibrate an iMac-based Touchscreen system

Install, configure, and calibrate one or more touchscreen monitors in a
G3-based system

Install the touchscreen software
Customize the touchscreen for your working environment

Use the Microcal Diagnostic Utility for troubleshooting, and to test,
recalibrate, and linearize touchscreen monitors

It is assumed throughout that a monitor to be used with a G3 system has had a
touchscreen and controller installed (new iMac-based systems are always
fully assembled). If you need to fit your monitor with a touchscreen and a
controller, please refer to the Touchscreen Kits Installation Guide supplied
with your documentation package.
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What You Need to Know

This document assumes you have basic computer skills. You should know
how to use the mouse and keyboard, choose commands from menus, open
and run application programs, and save files.

If you need to learn more about these tasks, refer to the manuals and CD-
ROMs that came with your Macintosh.

MicroTouch Support Services
MicroTouch provides extensive support services through our technical
support organization and our web site.
MicroTouch Technical Support

Technical Support is available as follows:
* 24 hours a day, Monday through Friday (excluding holidays)

e 9:00 a.m. to 5:00 p.m. Eastern Standard Time, Saturday and Sunday
(excluding holidays)

Whenever you contact Technical Support, please provide the following
information:

» Part number and serial number from the MicroTouch label on your
monitor or touchscreen controller

» Type of MicroTouch touchscreen (resistive or capacitive)
» Version number of your MicroTouch TouchWare

* Make and model of your personal computer

» Name and version number of your operating system

» Type of mouse connected to your system

» List of other peripherals connected to your computer

e List of application software in use
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You can contact MicroTouch Technical Support by calling the hot line,
sending a fax, or sending electronic mail.

» Technical Support Hot Line: 978-659-9200
e Technical Support Fax: 978-659-9400

» Technical Support E-Mail: support@microtouch.com

MicroTouch on the World Wide Web
You can visit the MicroTouch web site at the following address:
http://www.microtouch.com

You can download MicroTouch touchscreen software and drivers, obtain
regularly updated technical information on MicroTouch products, and learn
more about our company.
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MicroTouch Systems, Inc.
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United States
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Introduction

The Universal Serial Bus (USB) is an industry-standard data
connection between computers and peripheral devices. It provides
transfer rates of up to 12 megabits per second, and two-way
communication between the computer and up to 127 devices
connected through branching USB hubs. USB devices are “hot-
pluggable”, that is, they may be connected and disconnected without
first shutting down the computer.

On the iMac and current-model G3 Macintoshes, the USB replaces
the Apple Desktop Bus (ADB) for connecting all external devices,
including the keyboard, mouse, and monitor. (Earlier G3s include
both USB and ADB ports.)

MicroTouch provides two versions of its USB monitors for the
Macintosh, one for the iMac and one for the G3.

The iMac-based system is self-contained and fully-assembled, with
TouchWare already installed and with complete Macintosh and
MicroTouch documentation and software.

Touchscreen monitors for use with G3-based systems include a
TouchWare CD-ROM and complete MicroTouch documentation.

On G3 systems, TouchWare for USB supports multiple monitors, up
to four of which may have touchscreens installed. The total number of
monitors is limited only by the hardware constraints of your G3
system.
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The two components of TouchWare are the Control Panel and the
Microcal diagnostic utility. Use the Control Panel to calibrate the
touchscreen, configure and map multiple touchscreens, and set your
preferences for touch mode, tap speed, and cursor offset. Use
Microcal for troubleshooting, screen linearization, and frequency
adjustments. You may also use Microcal for calibration and mapping.
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Installing the Touch Monitor

Installing an iMac-based system

Your iMac-based touchscreen system comes fully assembled and with
the MicroTouch software already installed on the hard drive. After
unpacking and inspecting the equipment (described in the next
paragraph), follow the instructions in the included Macintosh
documentation to connect the components and plug the system in,
then proceed directly to Chapter 3 to configure the touchscreen.

Unpacking

Carefully unpack the carton and inspect the contents for any damage.
Make sure you received the following items:

* iMac system with touchscreen and controller installed
» iMac keyboard, mouse, and power cord
» Macintosh documentation and software on CD-ROM

e TouchWare for USB software on CD-ROM
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Preparing for use

Follow the instructions in your included Macintosh documentation for
connecting the keyboard, mouse, and power cord. In addition, make
sure that the touchscreen controller cable is properly inserted into one
of the USB ports on the side of the iMac.
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Installing a G3-based system

Minimum System Requirements

To run TouchWare for Macintosh (USB controllers), the following
minimum requirements must be met:

* MacOS version 8.5 or later
« USB for Macintosh version 1.1 or later*

» Touchscreen controllers with Output Identity number U1.2.0 or
later

Unpacking the Touch Monitor

Carefully unpack the carton and inspect the contents for any damage.
Make sure you received the following items:

* Monitor with attached touchscreen controller and cable. The
controller may be mounted on the back of the monitor or installed
inside the monitor.

» TouchWare for Macintosh (USB controllers) CD-ROM.

» A shrink-wrapped set of manuals. Check these documents against
the list enclosed in the package.

MicroTouch provides one copy of the software and documentation
with your initial system. Order these items separately for each
additional system.

Save the invoice, shipping container, and all packing material in case
you need to transport the equipment any time in the future.

! Systems with Versions 1.0 or 1.01 can be upgraded. See “Which version of USB do you have?” in
Chapter 2.
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Connecting the Touch Monitor

Connecting a touch monitor to your Macintosh is straightforward.
There are three cables:

* The monitor video cable

» The touchscreen cable

e The monitor power cable

The monitor video cable is connected to a video port in the G3.

The touchscreen cable is connected, either directly or through a USB
hub, to a USB port on the G3 system unit.

Touchscreen
controller

Touchscreen cable

Monitor video cable

The monitor power cable is connected to a convenient outlet.
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How to Connect a Touch Monitor

1. Turn off your computer. Although connections to a USB port may
be made while the computer is running, connecting (and
disconnecting) a video cable should be done with the computer
off.

2. Connect the monitor video cable to the video port on the back of
the G3.

3. Connect the touchscreen cable to any available USB port. This
may be on the back of the G3 system unit, on the keyboard, or on
a USB hub connected to the system.

4. Connect the monitor’s power cable to a grounded 3-prong outlet.

5. Turn on your Macintosh. You are now ready to install the software
for your touchscreen.

How to Connect Multiple Touch Monitors

Each monitor, standard or touch, is connected to a separate video port
in the Macintosh. To support multiple touch monitors, you may need
to install additional video cards. Refer to your Macintosh
documentation for information on installing and configuring multiple
video cards.

All touch monitors are connected to the Macintosh in the same way.
Follow the procedure described previously in “How to Connect a
Touch Monitor” for each touch monitor.

Note: When connecting multiple touch monitors in a system, each
touchscreen controller must have an Output Identity of U1.2.0 or
newer.




18 Installing the Touch Monitor

Checking Touchscreen Operation

After you have connected the touch monitor(s) to the Macintosh you
should carry out the following checks to determine whether the
touchscreen hardware is working properly.

» To check a touchscreen:
1. Turn on your Macintosh and monitor(s).

2. Adjust the contrast and brightness to suit your personal preference
and working environment.

3. Make sure the video image is centered within the screen area. Use
the horizontal and vertical controls to adjust the video, if
necessary.

4. (G3 systems only) Look at the status light on the touchscreen
controller.

» If the status light is on, the controller is receiving power and is
operating properly.

» If the status light is blinking, the controller’s internal self-test
failed. There may be a problem with the controller hardware.
Contact MicroTouch Technical Support for more information.

5. (G3 systems only) Touch the screen while looking at the status
light on the touchscreen controller.

» If the status light brightens when you touch the screen, and
dims when you remove your touch, the touchscreen is
functioning properly.

» If the status light remains dim when you touch the screen, the
touchscreen is not functioning properly. Contact MicroTouch
Technical Support for more information.

Checking Multiple Touchscreens

If you are using multiple touch monitors, repeat the check procedure
for each touchscreen.
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Installing the Touchscreen Software

Note: This discussion applies mainly to G3 systems, but also to iMac
systems on which TouchWare must be reinstalled (such as after a
system crash).

If your system is running MacOS version 8.6 or later, proceed directly
to the section “Files on the TouchWare CD-ROM”.

Which version of USB do you have?

If you are running MacOS version 8.5 or 8.51, you must first
determine which version of the Macintosh USB software your system
supports, because TouchWare will not work with any USB software
earlier than version 1.1.

1. Run the “Apple System Profiler” (This should be located in your
Apple Menu)

2. Go to the “Devices and VVolumes™” Tab.

3. The USB version is the first piece of information. If the version is
1.0 or 1.01, you will need to update the USB software to USB 1.1
or higher. See www.apple.com for an upgrade. MacOS8.6 (or
higher), which supports USB version 1.2, is highly recommended.



http://www.apple.com/
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Files on the TouchWare CD-ROM

Insert the TouchWare for Macintosh (USB controllers) CD-ROM into
the CD-ROM drive, and double-click on the CD-ROM icon to display
the contents. Table 1 describes these files.

Table 1. TouchWare Files

Icon File Name Purpose
TouchWare Control panel and touchscreen driver.
Enables the touchscreen to work with
== .
TaucHYare your Macintosh.
Microcal Diagnostic utility for testing and
adjusting touchscreen parameters.
Microcal

USBTouchscreenModule Driver, interface between the

IE Touchscreen controller firmware and
MacOS.

USBTouchscreenShim  Code fragment that allows applications
to communicate with USBTouch-
ScreenModule even if the Touchscreen
monitor is disconnected.

TouchWare ReadMe Text file that contains the latest
S documentation for the product. Be sure
TouchyYare to check the information in the
Readhie ReadMe file before you install and use

the touchscreen software.
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Viewing the ReadMe File

The TouchWare CD-ROM includes a ReadMe file, which contains
product summary and enhancement information.

Before you install the touchscreen software, refer to the ReadMe file
for any last-minute changes and updates.

To view and print the ReadMe file:

1. Insert the TouchWare for Macintosh (USB controllers) CD-ROM
into the CD-ROM drive.

2. Double-click on the CD-ROM icon to display the contents.

3. Double-click on the ReadMe file. The system automatically uses
the Macintosh SimpleText application to open and display the
document.

» To view the document, use the scroll bar and arrow keys to
display the next and previous pages.

* To print the document, open the File menu and choose Print.

When you are done, open the File menu and choose Quit. The system
closes the file, exits from the SimpleText application, and returns to
the Macintosh desktop.
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First-Time Installation

Note: If you are upgrading from an earlier version of TouchWare, you
must first remove the older files. Please see the section “Upgrading
from a Previous Version” for procedures.

p» To install TouchWare:

1. Open the Control Panels folder. This folder is located in the
System Folder on your Macintosh startup drive.

2. Insert the TouchWare for Macintosh (USB controllers) CD-ROM
into your CD-ROM drive.

3. Installation for MacOS 8.5 or 8.51 with USB 1.1:
a. Locate the USB1.1 folder on the CD-ROM.

b. Copy the “USBTouchScreenModule” and the
“USBTouchScreenShim” files to the Macintosh Boot Drive
Extensions folder.

Note: These extensions must reside in the Extensions folder.

c. Proceed to Step 5.

4. Installation for MacOS 8.5 or 8.5.1 with USB 1.2 or MacOS8.6
and higher:

a. Locate the USB1.2 folder on the CD-ROM.

b. Copy the USBTouchScreenModule and the
USBTouchScreenShim files to the Macintosh Boot Drive
Extensions folder.

Note: These extensions must reside in the Extensions folder.

5. Locate the TouchWare Control Panel folder on the Installation
CD, and copy its files to the Macintosh Boot Drive Control Panels
folder.
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7.

Note: These files must reside in the Control Panels folder.

Highlight the Microcal file and copy the file from the CD-ROM to
your Macintosh system drive. You can place the Microcal file
anywhere on your hard drive except in the Systems folder.

Reboot the system.

Upgrading from a Previous Version

To upgrade from an earlier version of TouchWare:

1.
2.
3.

Open the System Folder on the Boot Drive.
Open the Control Panel Folder.

Locate the TouchWare file and remove it from the Control Panel
Folder. You can delete it if you have a backup.

Locate the Microcal Application on the local Hard Drive. You can
delete it if you have a backup.

Follow the instructions above in “First-Time Installation”.
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Completing the Installation

To complete the installation you must calibrate each touch monitor to
insure that the touchscreen is aligned properly with the underlying
video. Calibration also allows you to perform additional tests to
determine that the touchscreen is functioning properly and accurately.

Systems with a Single Monitor (iMac or G3)

For iMac systems and G3 systems with a single monitor and
touchscreen, go directly to Chapter 3, “TouchWare Control Panel”,
for the calibration procedure. This chapter begins with a brief tutorial
on using the TouchWare Control Panel. When you have completed
the calibration, you may then customize the operation of your
touchscreen to suit your needs.

G3 Systems with Multiple Monitors

If your system includes multiple monitors, you must configure your
Macintosh system and map the monitors before you can calibrate the
touchscreen(s). Please refer to Chapter 5, “Multiple Touch Monitors”,
for procedures.

After you have completed the configuration and mapping, go to
Chapter 3, “TouchWare Control Panel”, for the calibration procedure.
Calibrate each touchscreen in your system. Test each calibration.
When you have completed the calibration, you may then customize
the operation of your touchscreens to suit your needs.



= 1
TouchiMare

CHAPTUER 3

TouchWare Control Panel

The TouchWare control panel lets you customize the operation of
your touchscreen by selecting the way the cursor responds as you
touch the screen and as you move your finger.

You can use the TouchWare control panel to

Select and change the touch mode
Change the tap speed and tap area
Calibrate the touchscreen

Adjust the cursor vertical offset
View the monitor IDs

Map the touchscreens

Perform a soft reset
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Control Panel Basics

The TouchWare control panel allows you to customize how your
touchscreen responds. You can specify the touch mode, tap speed and
area, and cursor vertical offset. In addition, you can calibrate your
touchscreen or issue a soft reset.

Opening the Control Panel

P To access the TouchWare control panel, use one of the following

methods:

* Open the Apple menu (#). Choose Control Panels and select
TouchWare.

* Open the System Folder and then open the Control Panels folder.
Double-click on the TouchWare file.

=|

O Touch¥are
Global Touchscreen Settings
Touch Faode Tap Speed
E:, Liftaff Slow El {:} l:::l Fast
{::l Tap Tap Area
(3 Drag Large 3 ) Sman

l

Vertical Offset |

Individual Touchseresn Settings

[ calibrate |

[ Reset

l

[ Show Monitor IDs ]

[ Map Touchscreens ]

[Select Touchscreen |

— A global setting is
applied to all
touchscreens
simultaneously.

An individual setting
is applied to the
current touchscreen
only.

-

The Map Touchscreens
option is enabled only
when multiple monitors
are installed.

| Monitor 1D of Current Touchscreen: 2

The Select Touchscreen
option is enabled only when
multiple touchscreens are

connected.
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Global Versus Individual Settings

Note that the control panel has two types of settings:
» Global Touchscreen Settings

* Individual Touchscreen Settings

A global setting is applied to all touchscreens in a system
simultaneously. An individual setting is applied to the currently
selected touchscreen only.

The difference between a global and an individual setting is important
only if you have more than one touch monitor connected to your
system.

If your system has only one touch monitor, all settings are applied to
that touchscreen.

Options for Multiple Monitors

The Show Monitor ID option, the Map Touchscreens option, and the
Select Touchscreen option help you to configure your system for
multiple monitors. TouchWare dims the option if it is not valid for
your configuration.

For more information on using multiple monitors, refer to Chapter 5.
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Calibrating the Touchscreen

Calibration is the process of aligning the touchscreen with the
underlying video. Calibration defines the dimensions of the image
area of the screen, determines the edge of the screen image, and
locates the center of the touchscreen. You should always calibrate at
the screen resolution you will be using.

When You Should Calibrate

You should calibrate the touchscreen in the following cases:

» After you have initially installed your touch system

* Any time you change your video card, swap in a new monitor, or
add another touch monitor

* Any time the cursor does not accurately follow the movement of
your finger

* Any time you cannot position the cursor at the edges or corners of
the screen image

* Any time you change the size or position of the video image area
by adjusting the controls on your monitor

» Any time you adjust the touchscreen operating frequency

* Any time you issue a Restore Factory Defaults command

How to Touch the Screen During a Calibration

Calibration requires you to touch targets that are displayed on the
screen. To obtain the most accurate calibration results:

» Touch each target with the fingertip of an extended finger.

» Keep your palm and free hand away from the touchscreen and
monitor.

» Touch as close to the center of the target as possible.
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* Remember that the liftoff position — not the touchdown position —
determines the calibration point when you calibrate the
touchscreen. Therefore, if your touch position is not quite centered
on the target, you can slide your finger to the center of target, hold
steady momentarily, and then lift your finger off the screen.

» Hold your finger as still as possible after you reach the final
calibration location. Always lift your finger straight off the
touchscreen. Do not use any swiping motion during liftoff.

Calibration Procedure

The calibration procedure is quick and easy, and insures that the
touchscreen is aligned with the underlying video image. Data from
this procedure is stored within the touchscreen controller in non-
volatile memory. This means that you do not need to calibrate your
touchscreen each time you turn on your system.

If you have multiple touchscreens installed, refer to Chapter 5,
“Multiple Touch Monitors,” for information on selecting a
touchscreen. Calibration is an individual option which requires that a
touchscreen be selected.

» To calibrate the touchscreen:

1. Make sure the monitor has been powered on for at least five
minutes. This allows the monitor to reach its normal operating
temperature and stabilize before you attempt to calibrate the
touchscreen.

2. Open the TouchWare control panel.

3. Select Calibrate. A calibration target appears in the lower left
corner of the screen.
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4.

Touch the center of the target. Make sure to follow the guidelines
described previously in “How to Touch the Screen During a
Calibration.” Hold your touch for at least three seconds.

When you lift your finger, a second calibration target appears in
the upper right corner of the screen.

Touch the center of the target. Make sure to follow the guidelines
described previously in “How to Touch the Screen During a
Calibration.” Hold your touch for at least three seconds.

When you lift your finger, TouchWare saves the new calibration
values and returns to the control panel.

Note: The calibration routine will automatically exit if no touch is
detected within 25 seconds. In this case, the current calibration
values are not changed.

Testing the Calibration

» To test the accuracy of your calibration:

1.

Touch the center of the screen and check that the cursor is located
underneath your finger.

Drag your finger across the screen and check that the cursor
follows your movements.

Move your finger to each corner and edge of the screen. Check
that the cursor follows your finger and reaches the edges of the
screen image.

If any part of the calibration test fails, calibrate the touchscreen again.
Make sure to touch the targets carefully. It is possible that one of your
touches did not register properly, or you accidentally touched the
screen in the wrong place during calibration. For example, if you
touch beyond the targets or into the black non-image area, you will
distort the touchscreen calibration.

If you are still experiencing problems with the cursor positioning or
touch accuracy, refer to “Testing the Touchscreen” in Chapter 4.
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Calibration Resets the Vertical Offset

The calibration routine resets any previously applied cursor vertical
offset to zero. After a calibration is done, you need to set the vertical
offset again.

Setting a Cursor Offset

After you calibrate the touchscreen, the cursor should be located
directly underneath your finger when you touch the center of the
screen. However, you may prefer to offset the cursor slightly above
your finger so that you can point more easily and precisely.

The Vertical Offset option lets you define the amount of space
between your finger touch and the position of the cursor on the screen.
Offsetting the cursor is helpful when selecting small items, such as
single letters in word processing, check boxes, or radio buttons.

The Vertical Offset option is a global setting. Whether you have one
or several touch monitors installed in your system, the offset you set is
applied to all touchscreens simultaneously.

» To offset the cursor:
1. Open the TouchWare control panel.
2. Select Vertical Offset. The following screen appears:

TO OFFSET THE CURSOR
&BOYE YOUR FINGER,
TOUCH AND LIFTOFF THE
DESIRED DISTAMCE BELOW
THE ARROW

The tip of this arrow represents
the position where the cursor will
appear relative to your finger.
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3. Touch the screen below the tip of the arrow. You can drag your
finger into position. TouchWare does not calculate the offset
amount until you lift your finger off the screen. The vertical
distance between your finger’s liftoff point and the tip of the
arrow is the offset amount. Thereafter, the screen cursor will be
positioned above your finger by the offset amount.

Note: You can automatically set the cursor offset to zero by
selecting the Reset option.

The following conditions apply to the cursor offset:

* When you calibrate the touchscreen, TouchWare automatically
resets the cursor offset to zero.

» As your finger approaches the bottom edge of the screen, the
cursor offset decreases automatically so that you can touch items
in this area.
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Selecting a Touch Mode

Touch mode defines exactly how your touch will be interpreted by
your computer. Use the Touch Mode option to specify the touch
actions that equate to mouse events like clicking, double-clicking, and
dragging.

The Touch Mode option is a global setting. Whether you have one or
several touch monitors installed in your system, the touch mode you
select is applied to all touchscreens simultaneously.

There are three touch modes available:

Tauzh Made

(@) Liftofr
() Tap
l:::' [rag

In describing these touch modes, the following terminology is used:
e Touch means to place your finger on the screen

» Tap means to touch the screen and quickly lift your finger off the
screen

Liftoff Mode

In liftoff mode, the initial touch locates the cursor on the screen. You
can slide your finger around on the screen to reposition the cursor if
desired. When you lift your finger off the screen, a single click occurs
at that location. Lifting your finger is equivalent to pressing and
releasing the mouse button. Liftoff mode is the default touch mode.

To double-click, quickly tap the object twice, in the same location.

To drag an object, tap to select the object and then quickly touch the
object again. The second touch is equivalent to pressing and holding
down the mouse button. You can now slide your finger to drag the
object to a new location. When you are satisfied with the new
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location, lift your finger off the screen. Lifting your finger is
equivalent to releasing the mouse button.

For a double-click or drag to occur, the second touch must take place
within the tap speed and area settings defined in the TouchWare
control panel. If the second touch is outside these limits, the
touchscreen interprets it as a new touch. Refer to the description of tap
speed and tap area later in this chapter.

Tap Mode

In tap mode, the initial touch only locates the cursor on the screen.
You can lift your finger off the screen and then touch the screen again
to reposition the cursor if desired. Lifting your finger off the screen
does not produce a click.

To click, tap the object twice, in the same location.
To double-click, tap the object three times, in the same location.

To drag an object, tap to select the object and then quickly touch the
object again. Dragging in tap mode is identical to dragging in liftoff
mode. The second touch is equivalent to pressing and holding down
the mouse button. You can now slide your finger to drag the object to
a new location. When you are satisfied with the new location, lift your
finger off the screen. Lifting your finger is equivalent to releasing the
mouse button.

Note that the taps must take place within the tap speed and area
settings defined in the TouchWare control panel. If a subsequent tap is
outside these limits, the touchscreen interprets the tap as a new touch.
Refer to the description of tap speed and tap area later in this chapter.
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Drag Mode

In drag mode, the initial touch is equivalent to pressing and holding
down the mouse button. You can drag your finger to move an object,
size windows, scroll through menus, or highlight text. When you are
done dragging, lift your finger off the screen. Lifting your finger is
equivalent to releasing the mouse button.

When using drag mode, be sure to precisely place your finger when
you touch the screen because some programs activate a selection on
the touch, rather than on lift off.

To click, touch the object and then lift your finger off the screen.

To double-click, quickly tap the object twice, in the same location.
Double-click in drag mode is identical to double-click in liftoff mode.
Also, for the double-click to occur, the second touch must take place
within the tap speed and area settings defined in the TouchWare
control panel.

To drag an object, touch the object and then drag the object to a new
location. Remember in drag mode the initial touch is equivalent to
pressing and holding down the mouse button.
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Summary of Touch Modes

Table 2 summarizes the events associated with each touch mode.

Table 2. Comparison of Touch Modes

Event

Liftoff Mode

Tap Mode

Drag Mode

When the
action occurs

A touch positions
the cursor. Lifting
your finger is
equivalent to

A touch positions
the cursor. No
action occurs
when you lift your

Atouch is
equivalent to
pressing and
holding down the

pressing and finger off the mouse button.
releasing the screen. Lifting your finger
mouse button. is equivalent to
releasing the
mouse button.
Click « Touch the screen. « Tap the object « Touch the object.
. . twice, in the same . .

« Slide your finger location. « Lift your finger
to position the off the screen.
cursor, if
necessary.

« Lift your finger
off the screen.

Double-click « Tap the object « Tap the object « Same as liftoff
twice quickly at three times, in the mode.
the same location. same location.

Drag « Tap the object « Same as liftoff « Touch the object.

and then quickly
touch it again.

Drag the object to
a new location.

Lift your finger
off the screen.

mode.

Drag the object to
a new location.

Lift your finger
off the screen.
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Setting the Tap Speed and Tap Area

The tap speed and tap area define the conditions that must exist for
the system to interpret your touches as a double-click or drag.

Tap speed and area are global settings. They are applied to all
touchscreens in your system simultaneously.

The tap speed defines how quickly you must touch the screen for the
system to register a double-click or drag. In other words, speed
defines how much time can elapse between touches.

Tap Speed

Slow @ {:} D Fast

» Slow speed - allows for more sedate movements because the time
allowed between touches is long

e Medium speed — suitable for most applications
» Fast speed — provides for rapid touch and tap recognition

The tap area defines the maximum area in which successive touches
will be recognized as occurring at the same touch point. In other
words, area defines how close one touch must be to the next touch for
the system to register a double-click or drag.

Tap Area

Large @ l:::l ll:l Srall

» Large Area — the area for subsequent touches is big
e Medium Area — suitable for most applications

» Small Area — the area for subsequent touches is small and precise

If your next touch occurs within the defined tap speed and area, then a
double-click or drag occurs. If the next touch is not within the defined
speed and area, then the system interprets the touch as a new first
touch.
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If the tap speed is fast, and you tap slowly, the application interprets
two successive taps as two single clicks, rather than as a double-click.
Alternatively, if the tap area is small, and your taps are a large
distance apart, the application interprets two successive taps as two
single clicks, rather than as a double-click. The best setting depends
on your application.

Using Monitor IDs

The Macintosh operating system creates an identification number for
each monitor connected to it. You use these monitor IDs when
mapping and selecting touchscreens

Displaying All Monitor IDs

Use the Show Monitor IDs option to display the Monitor IDs on the
screen of each monitor in your system. When you select the Show
Monitor I1Ds option, TouchWare displays an ID number on each
monitor screen for two seconds. The Show Monitor IDs option is
especially useful if your system has multiple monitors installed.

Viewing the Monitor ID of Current Touchscreen

Located at the bottom of the TouchWare control panel is the Monitor
ID of Current Touchscreen status. This status identifies the currently
selected touchscreen for systems configured with multiple
touchscreens. Individual settings, such as Calibrate and Reset, only
apply to the current touchscreen.

Mapping the Touchscreens

When you have multiple monitors installed, TouchWare needs to
know which monitors have a touchscreen installed. You use the Map
Touchscreens option to assign each touchscreen to its associated
monitor. For more information, refer to Chapter 5.
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If you do not have multiple monitors installed, the Map Touchscreens
option is not enabled. There is no need to map your touchscreen if you
have only one monitor.

Performing a Soft Reset
When you select the Reset option, the system

» Recalculates the touchscreen operating conditions (for example,
stray and offset capacitance values).

* Resets the cursor vertical offset to zero. You will need to set the
vertical offset again.

The Reset option does not alter the hardware operation. Instead, the
Reset option updates the controller’s information about the
touchscreen operating conditions.

It is useful to issue a soft reset if you are troubleshooting a problem
with your touchscreen or if you want to automatically set the vertical
cursor offset to zero.
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Getting Information About TouchWare

To obtain information about TouchWare, use the Get Info command.
This information includes such items as version number, file size, and
modification date.

P To view information about TouchWare:

1.

Highlight the TouchWare file name or icon in the Control Panels
folder.

Open the File menu and choose Get Info. The TouchWare Info
window appears.

O

TouchWare Info

B

E 1TuuchWare |
— —

5.3.0, @ 1983 - 1999 MicroTouch Systems, [nc.
) .Shnw:[ General Information i]

Kind: contral panel
Size: 44 K ondisk {43,152 bytes)
Yhere: Macintosh HD: System Folder: Control Panels:

Created: Fri, Aug 27, 1999, 5:04 PM
Modified: YWed, Sep 1, 1999, 10:12 AM
Yersion:5.3.0, © 19585 - 1999 MicroTouch Systems,
Inc.
Label:| None 2|

Comments:

O Locked
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CHAPTUER 4

Microcal Diagnostic Utility

The Microcal utility lets you test and adjust the performance of the
touchscreen. The set of Microcal options is for diagnostic purposes
only. You do not need to run Microcal unless you are experiencing
problems with your touchscreen.

You can use Microcal to

Verify that the touchscreen is properly connected

View the status information of the current touchscreen

Test the performance of the touchscreen using the Draw program
Calibrate the touchscreen

Adjust the touchscreen operating frequency

Linearize the touchscreen

View the Monitor IDs

Map touchscreens

Reset the touchscreen controller

Restore the touchscreen factory defaults
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Microcal Basics

Microcal lets you test and adjust the performance of the touchscreen,
and is a useful tool in troubleshooting any problems.

Opening Microcal

To open the Microcal utility, double-click on the Microcal file.

E : _
gﬂ Select Touchscreen \ / Linearize
Eﬁ Draw Show hMonitor 10s
I
Icons for accessing T ;
the Microcal options - Calibrate % Map Touchscreens
Adjust Frequency Quit

Current Touchscreen Status

Output Identity: U1.2.0 Capacitive
MonitoriD: 1
Touchscreen communic ating.

Touchscreen status
information

Every time you open Microcal, the system automatically

» Searches for connected touchscreens by scanning the USB device
table and obtaining the addresses of the touchscreens

« Attempts to communicate with each touchscreen by sending a
request for information to each controller in succession
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Selecting Microcal Options

You can select a Microcal option in one of three ways:

Touch or click on an icon in the Microcal window

Choose a command from the Options menu

When the Microcal window is active, the Options menu appears in
the menu bar. Open the Options menu and select the desired
command.

Options

Select Touchscreen #S
Draw #D
Calibrate #C
Adjust Frequency FA
Linearize L
Reset Controller #R
Restore Factory Defaults ¥*F
Map Touchscreens FM
Show Monitor IDs 38l
Quit #*Q

Note that the Options menu includes two commands — Reset
Controller and Restore Factory defaults — that are not in the
Microcal window.

Use the option command key sequence
Note that the Options menu lists the corresponding key sequence

next to each command. For example, press 3C to calibrate the
touchscreen. The key sequences are valid anytime the Microcal
window is selected.
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Touchscreen Status Information

The bottom portion of the Microcal window displays status
information for the currently selected touchscreen.

Current Touchscreen Status

Output Identity: UL.2.0 Capacitive
Monitor 1D: 1
Touchscreen communicating.

If you are using one touch monitor, that monitor is always the current
touchscreen.

If you are using multiple touch monitors, the last monitor you selected
is the current touchscreen.

Output Identity

The Output Identity specifies the controller type and firmware version
for the currently selected touchscreen. The format is as follows:

Output Identity — U1.x.x Type

where:

Ul defines the controller as a USB controller.

X.X indicates the firmware version. The first digit represents
the current major revision; the second represents the
current minor revision.

Type Indicates the type of touchscreen: Resistive or Capacitive.

If you are installing multiple touch monitors, the controller’s output
identity must be U1.2.0 or newer for each touchscreen. You can
determine the identity of each controller in your system by selecting
each touchscreen and reading its status information.
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Monitor ID

The currently selected touchscreen is identified by the ID number of
its associated monitor. Refer to “How to Select a Touchscreen” in
Chapter 5 for information on selecting a touchscreen when you have
multiple touch monitors installed.

Status Information Line

The information displayed on this line consists of:

Progress messages

For example, when you open Microcal, it searches for connected
touchscreens. Information about the progress of this search is
displayed.

Description of each Microcal option

You can display a brief description of an option by placing the
cursor on the icon and holding the mouse key down. To avoid
selecting the option, slide the cursor off of the icon before
releasing the button.

Results of the last operation performed

Error messages
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Testing the Touchscreen

If you are experiencing problems with the tracking and accuracy of
your cursor, then you need to test your touchscreen.

There are three factors that affect the operation and accuracy of your
touchscreen:

o Calibration
» Operating frequency
» Linearization

Using the Draw option in the following procedures will help you to
determine the best course of action for correcting your touchscreen
problem.

Using the Drawing Option

The Draw option lets you touch the screen and draw lines, shapes, and
curves. This option is useful for testing the touchscreen’s performance
and cursor movement.

When you choose the Draw option, the system displays a drawing
canvas with a grid. To draw, touch the screen and drag your finger.
Table 3 lists the keys you can press during a drawing session.

Table 3. Keys for Microcal Draw

Press ... To ...

B Clear the screen (including the grid) and then display a blank screen
G Clear the screen and then display the grid only

H Display the list of keys you can press during the drawing session

Q or Esc Exit from the drawing program

Any time you calibrate the touchscreen, linearize the touchscreen, or
adjust the operating frequency, use the Draw option to test your
changes.
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Determining the Probable Cause

To test the current touchscreen:

1.

2
3.
4

Open Microcal.
Select Draw.
Press G to clear the screen and display the grid.

Move your finger along the edges of the image area from corner to
corner, making the shape of a box. Do this several times

Look at the box you drew on the screen.

Your lines should smooth and straight, and be aligned with the
edges of the image area. Verify that the cursor reaches the full
image area of the screen.

If you cannot move the cursor to all corners and edges of the
screen, then you need to calibrate the touchscreen. Refer to
“Calibrating the Touchscreen” in Chapter 3.

!

—T— > The edges of the box are
not aligned with the
edges of the video image.

—

Press G to clear the screen and display the grid.

Trace each of the vertical lines displayed on the screen. Your lines
should follow the grid and be straight and smooth. Your lines
should be similar in appearance to each other.

Trace each of the horizontal lines displayed on the screen. Your
lines should follow the grid and be straight and smooth. Your lines
should be similar in appearance to each other.

Look at the lines you drew on the screen.
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If your lines are straight and smooth, but are offset a distance from
the grid lines, then your touchscreen requires calibration. Refer to
“Calibrating the Touchscreen” in Chapter 3.

\
j : T% The lines appear smooth
= and straight, but are offset
A a distance from the grid
T lines.

I

If your lines are jagged, rough looking, or intermittent, you need to
adjust the touchscreen operating frequency.

T %]
‘E; The lines have a
E v 4 4 ragged appearance.
] S
13 = *
) ~¥

D ]

Also, if the cursor is jittery, does not move with your finger, or
requires a hard touch to move, you need to adjust the frequency.

Refer to “Adjusting the Operating Frequency” later in this chapter
for more information.
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If your lines are curved or distorted, and you are still experiencing
problems with cursor tracking and accuracy, then you probably
need to linearize your touchscreen. Refer to “Linearizing the
Touchscreen” later in this chapter for more information.

Most of the lines appear straight.
However, some portions of the
lines are curved.

/ AT
—

\

\\

10. Press Q to quit Draw.

When You Should Contact Technical Support

If you have calibrated the touchscreen, adjusted the operating
frequency, and linearized the touchscreen, but are still experiencing
tracking and accuracy problems with your cursor, contact MicroTouch

Technical Support.
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Calibrating the Touchscreen

Calibration is the process of aligning the touchscreen with the
underlying video. The calibration process determines the dimensions
of the screen, the location of the edges of the screen image, and the
center of the touchscreen. You should always calibrate at the screen
resolution you will be using.

You should calibrate the touchscreen in the following cases:

After you have initially installed your touch system

Any time you change your video card, swap in a new monitor, or
add another touch monitor

Any time the cursor does not accurately follow the movement of
your finger

Any time you cannot position the cursor at the edges or corners of
the screen image

Any time you change the size or position of the video image area
by adjusting the controls on your monitor

Any time you adjust the touchscreen operating frequency

Any time you issue a Restore Factory Defaults command

The Calibration option in Microcal is identical to the Calibration
option in the TouchWare control panel. Refer to “Calibrating the
Touchscreen” in Chapter 3 for a complete description of how to
calibrate your touchscreen.
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Adjusting the Operating Frequency

In general, your touchscreen is immune to any electrical noise that
may be present in the monitor. However, sometimes this “noise” may
be at the same frequency as the operating frequency of your
touchscreen. This noise could interfere with your system and prevent
it from receiving clear, quality signals when you touch the screen.

The solution to this problem is to change the operating frequency of
your touchscreen.

When You Should Adjust the Frequency

You should adjust the operating frequency if

e The cursor is jittery or erratic when you touch the screen

» Your straight lines drawn in Microcal Draw appear ragged

e The cursor does not track (follow) your finger smoothly as you
drag it across the screen

* You have to press hard on the screen to register a touch

Adjusting the Frequency

To obtain a clear touch signal, use the Adjust Frequency option to
change the operating frequency of the touchscreen. The range of
adjustment is from 29.412 kHz to 50.000 kHz. The factory default is
38.462 kHz.

Frequency changes apply to the current touchscreen. If you have
multiple touch monitors installed be sure to select a touchscreen
before adjusting frequency. Refer to “How to Select a Touchscreen”
in Chapter 5 for more information.
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P To adjust the operating frequency:
1. Open Microcal.
2. Select Adjust Frequency to display the following dialog box:

Adjust Frequency

Currentfrequency 38462 Default

Previous frequency 77777

Mew frequency 38462

Higher | | i [4]+] Lower

The Adjust Frequency dialog box displays the frequency the
touchscreen is currently using and the frequency last used.

Note: Microcal retains only the current frequency when it is
closed. Each time you open Microcal, the previous frequency box
will contain a string of question marks (????7?).

3. Use the scroll bar to select a new frequency. Alternatively, you can
select Default for the default frequency (38.462 kHz).

4. Select Set. Microcal inputs the new frequency, and then
automatically opens the Draw program so you can test the new
setting.

Testing the New Frequency

When you choose Set, Microcal opens the Draw program. Test the
new frequency by drawing several horizontal, vertical, and diagonal
lines. Look for the lines to be smooth and straight. Touch the screen
and observe the cursor. It should be steady.
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You can use the following keys when working with the Microcal
drawing program:

Press F to exit the draw program and return to the Adjust
Frequency dialog box. This allows you to conveniently set and test
another frequency without exiting the Adjust Frequency option.

Press G to clear the screen and then display a grid. This allows
you to erase lines you have drawn. The grid provides a guide for
drawing straight lines.

Press B to clear the screen (including the grid) and then display a
blank screen. This allows you to erase the lines you have drawn.

Press Q or ESC to exit from the drawing program.

Press H to display the list of keys you can press. If the list is
already displayed, pressing H will have no effect.

You should select several operating frequencies. Test your
touchscreen at each frequency. If you can obtain good results at more
than one frequency, choose the highest frequency in order to obtain
optimum performance. In general, a higher frequency produces a
stronger touch signal.

The operating frequency you select is stored in the touchscreen
controller. The touchscreen will operate at the frequency you set until
you change it again.
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Linearizing the Touchscreen

Note: During the manufacturing process, MicroTouch carefully
linearizes each touchscreen by performing a computer controlled 25-
point analysis. This linearization analysis insures that every
touchscreen operates with the highest degree of accuracy. For this
reason, the “Linearize” option on the Microcal menu is grayed out and
cannot be accessed under normal circumstances.

Normally, you should never have to perform the linearization
procedure. Before attempting to linearize your touchscreen, it is
important that you eliminate other factors, such as calibration and
frequency, that may be affecting the touch accuracy. To determine if
you need to linearize the touchscreen, follow the procedures described
in “Testing the Touchscreen” earlier in this chapter.

If after making all these tests you still find it necessary to linearize the
screen, please call MicroTouch Technical Support for the procedure
required to access the “Linearize” option.

How to Touch the Screen During Linearization

&

2

Linearization requires you to touch targets that are displayed on the
screen. To obtain the most accurate results:

» Touch each target with the fingertip of an extended finger.

» Keep your palm and free hand away from the touchscreen and
monitor.

» Touch as close to the center of the target as possible.

» Hold your finger as still as possible on the target. Always lift your
finger straight off the touchscreen. Do not use any swiping motion
during liftoff.
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Linearize Procedure

Linearization applies to the current touchscreen. If you have multiple
touch monitors installed, be sure to select a touchscreen to linearize.
Refer to “How to Select a Touchscreen” in Chapter 5.

If desired, you can restore the original factory linearization data by
selecting Restore Factory Defaults from the Microcal Options menu.

To linearize the touchscreen:

1.
2.

Open Microcal.

Select Linearize. Microcal displays 25 targets for you to touch in
sequence. Note that the upper left target has a cross through it. The
cross indicates the target you should touch.

You can cancel the linearization process at any time by pressing
ESC. Additionally, if no touch is detected within 25 seconds, the
linearization procedure will automatically terminate.

Touch each target, beginning with the target in the upper left
corner. Be sure to hold your finger on the target for at least four
seconds. Microcal takes multiple readings for each target.

Lift your finger off the first target. Microcal positions the cross on
the next target you should touch.

Note: If the cross does not advance to the next target, Microcal
did not receive an accurate reading for the current touch point.

Touch the target again making sure you hold your touch for at

least four seconds.

Repeat the process for all 25 targets.

When you touch the last target, wait for Microcal to complete its
calculations and return to the main menu. This process will take a
few seconds.
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Resetting the Touchscreen Controller
When you select the Reset Controller command, the system
* Re-initializes the touchscreen controller hardware and firmware
* Momentarily stops the controller from sending data

* Re-calculates the touchscreen operating conditions (for example,
stray and offset capacitance values)

The controller reset is applied to the current touchscreen. If you have
multiple touch monitors installed be sure to select a touchscreen
before resetting the controller. Refer to “How to Select a
Touchscreen” in Chapter 5 for more information.

Restoring Touchscreen Factory Default Parameters

The Restore Factory Defaults command in the Microcal Options
Menu causes the touchscreen to revert to the factory default operating
parameters. This command is useful in situations where inadvertent
commands or actions have rendered the touchscreen inoperative.

The system restores the defaults for the current touchscreen only. If
you have multiple touch monitors installed, make sure you select a
touchscreen before executing a Restore Factory Defaults command.
For information on selecting and using multiple touch monitors, refer
to Chapter 5.

Touchscreen linearization data, calibration data, and default operating
frequency are restored to their factory default values from data stored
in the touchscreen controller. You should always calibrate the
touchscreen after you have restored the defaults.

Note: Even though the operating frequency has been changed to the
default value, the frequency displayed in the Adjust Frequency dialog
box is updated only after Microcal is closed and re-opened.
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Using Monitor IDs

The Macintosh operating system creates an identification number for
each monitor connected to it. You use these monitor IDs when
mapping and selecting touchscreens

Displaying All Monitor IDs

Use the Show Monitor IDs option to display the Monitor IDs on the
screen of each monitor in your system. When you select the Show
Monitor I1Ds option, Microcal displays an ID number on each monitor
screen for two seconds. The Show Monitor IDs option is especially
useful if your system has multiple monitors installed.

Viewing the Monitor ID of Current Touchscreen

Located at the bottom of the Microcal screen is the Monitor ID of
Current Touchscreen status. This status identifies the currently
selected touchscreen for systems configured with multiple
touchscreens. Microcal options, such as Draw, Calibrate, Adjust
Frequency, Linearize, Restore Factory defaults, and Reset Controller,
only apply to the current touchscreen.

Mapping the Touchscreens

at1

When you have multiple monitors installed, TouchWare needs to
know which monitors have a touchscreen installed. You use the Map
Touchscreens option to assign each touchscreen to its associated
monitor. For more information, refer to Chapter 5.
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Selecting a Touchscreen

touchscreen when you have multiple touch monitors installed. Refer

j| The Select Touchscreen option allows you to select a specific
[ to “How to Select a Touchscreen” in Chapter 5.

If you do not have multiple touch monitors installed, this option is not
valid. There is no need to select a touchscreen if you have only one
installed.

Quitting Microcal
You can exit Microcal by
» Clicking the Stop icon

* Choosing Quit from the Options menu

* Pressing $Q on the keyboard

» Clicking the close box at the top of the Microcal window

Getting Information About Microcal

» To display information about Microcal:

1. Highlight the Microcal file name or icon in the Control Panels
folder.

2. Open the File menu and choose Get Info. The Microcal Info
window appears.
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Kind: application program
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Inc.

Yersion:5.30, @ 1991 - 1999 MicroTouch Systems,
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Comments:
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Multiple Touch Monitors

Note: Multiple monitors are supported only on G3 Macintoshes.

In applications where more than one touchscreen is required in a
system, MicroTouch has provided the solution. TouchWare easily
supports multiple touch monitors.

This chapter describes how to
e Setup multiple touch monitors
» Configure your system for multiple monitors

e Use multiple touch monitors

Note: TouchWare supports a maximum of four touch monitors
(touchscreens) in a system
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Multiple Touch Monitors

Multiple Monitor Overview

Your system can have a mix of standard and touch monitors. The
following are some examples of possible system configurations:

e One touch monitor
*  One touch monitor plus one or more standard monitors
e Two touch monitors

»  Two touch monitors plus one or more standard monitors

Installation and Setup

When you set up a system with multiple touch monitors, you may
need to install additional video ports in your Macintosh. Each
standard monitor or touch monitor is connected to a separate video
port. Refer to your Macintosh documentation for information about
installing additional video ports.

After you have installed and connected the hardware, you configure
your Macintosh operating system for multiple monitors. During this
process you select which monitor will be the main monitor. The main
monitor is the monitor that displays the menu bar.

Mapping

Each monitor is automatically assigned an identification number by
your Macintosh operating system. You can use the Show Monitor 1Ds
option to identify individual monitors in your system.
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Mapping is the process of assigning each touchscreen to its associated
monitor. Mapping accomplishes two purposes:

« |dentifies each touchscreen connected to the USB and its
associated monitor

+ Identifies which monitors are touch monitors and which monitors
are standard monitors

During the mapping procedure, you indicate that a monitor has a
touchscreen installed by touching the ID number displayed on its
screen. You indicate that a monitor does not have a touchscreen by
pressing the ESC key

Once mapping has been completed, the Macintosh is able to identify
the type of each monitor by its ID number.

Selecting a Specific Touchscreen

The options in the TouchWare control panel and Microcal are
grouped into two categories. Options that are applied to all of the
touch monitors in your system simultaneously are called Global
Touchscreen Settings. Options that are applied to a specific touch
monitor in your system are called Individual Touchscreen Settings.

Before you apply an individual touchscreen setting, you must first
select the specific touchscreen. The TouchWare control panel and
Microcal have a Select Touchscreen option for this purpose. You
select a touchscreen by touching the monitor ID number displayed.
Only monitors with touchscreens can be selected.
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Setting Up Multiple Touch Monitors
To set up a system with multiple monitors you
» Connect the monitors to the Macintosh
» Install the TouchWare software
» Configure the Macintosh operating system for multiple monitors

* Map the touchscreens

Note: Only touchscreens using controllers with an Output Identity of
U1.2.0 or newer are supported in multiple touch monitor
configurations.

Connecting the Monitors

Each monitor is connected to a separate video port in the Macintosh.
You may need to install additional video cards. Additionally, each
touchscreen is also connected to a USB port. Refer to “Connecting the
Touch Monitor” in Chapter 2 for information on connecting multiple
touch monitors.

Installing TouchWare

After you have connected the monitors to your Macintosh, you must
install the TouchWare software.

Refer to “Installing the Touchscreen Software” in Chapter 2 for the
installation procedure.

Configuring the Macintosh Operating System

When more than one monitor is installed in a system, you must
configure the Macintosh operating system for multiple monitors. The
Macintosh is then able to identify individual monitors in the system
by creating monitor identification numbers (Monitor 1Ds).
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» To configure the Macintosh for multiple monitors:
1. Open the Apple menu (s&) and select Control Panels.

2. Choose Monitors & Sound. Earlier versions of the Macintosh
referred to the option as Monitors.

3. Select the Arrange icon.

4. Arrange the monitor icons by dragging them on the screen. You
should position the icons according to how your monitors are
physically arranged. This could be side by side, or one above the
other

You can identify the monitors by clicking and holding the mouse
button on Identify the monitors. Make sure that the monitor icons
are not on top of one another.

Note: It is important that the monitors be configured as separate
monitors (non-mirrored) for proper touchscreen mapping.

5. Drag the menu bar onto the monitor icon that represents your main
monitor. The monitor with the menu bar is the main monitor. The
TouchWare control panel and Microcal window are displayed on
the main monitor.

6. Click the close box at the top of the window to exit the monitor
setup.

Mapping the Touchscreens

Mapping is the process of assigning a touchscreen to its associated
monitor by using the monitor ID number. Once mapping has been
completed, the software can reference any standard or touch monitor
by using the monitor IDs.

Note: The mapping procedure requires that a keyboard or mouse be
connected to your Macintosh.
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Anytime you change the number or type of the monitors in your
system, you must map the touchscreens. TouchWare always displays
an alert message if the touchscreen mapping is not correct.

» To map the touchscreens:
1. Open the Apple menu (%) and select Control Panels.

2. Select TouchWare. If this is the first time you opened the
TouchWare control panel or Microcal with multiple touchscreens
installed, or you changed the number or type of monitors in your
system, TouchWare displays the following alert message:

@ The touchscreen mapping for vour
Macintosh system is not correct.

To properly configure your system for
multiple monitors, vyou must map each
touchscreen to its corresponding
muonitor.
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3. Click OK. The system displays instructions on how to map your
touchscreens.

During the mapping process,the system will display an ID
number on each monitor in succession.

If a monitor has a touchscreen,touch the ID number to map
the touchscreen to the monitor.

If the monitor does not have a touchscreen, press the ESC key
orwaitten seconds for the process to continue
automatically.

cancel | |

You can select Cancel to exit the mapping procedure. However, if
you have modified the monitor configuration of your system, you

must map your touchscreens. Failure to do so will result in erratic
operation of your touchscreens.

4. Click Begin. The system displays an ID number on each monitor
in succession.

» If the monitor displaying the ID number has a touchscreen,
touch the ID number

If the system recognizes your touch, the following message
box appears:

Touchscreen mapped successfully to
monitor 1.
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« If the monitor does not have a touchscreen, press the ESC key.

If your touch did not register or you pressed the ESC key, the
following message box appears:

Mo touchscreen mapped.
Monitor 1 does not have a touchscreen or
the touchscreen is not responding.

If this monitor has a touchscreen, but your touch was not
detected, complete the mapping procedure before attempting
to troubleshoot the problem.

5. Click OK to continue mapping the remaining monitors in your
system.

When you have completed mapping all the monitors, the system
displays the results:

Touchscreen mapping completed,

2 Monitor{s) detected.

Z Touchscreen(s) detected.
2Touchscreen(s) mapped successfully.

If an error was encountered during mapping the system displays an
alert message. Restart your Macintosh and repeat the mapping
procedure. If the problem(s) persist, refer to Chapter 6 for
troubleshooting tips.
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Using Multiple Touch Monitors

When multiple touch monitors are installed, the touchscreen options
in the TouchWare control panel and Microcal are directed to either all
touchscreens simultaneously, or to a specific touchscreen. Otherwise,
the functionality of each option is the same regardless of the number
of touchscreens configured in your system.

The options are grouped into two categories:
» Global touchscreen settings

* Individual touchscreen settings

Global Touchscreen Settings

Global options are directed to all touchscreens at the same time. For
example, when you select the Touch Mode option in the control panel,
all touchscreens are set simultaneously to the same mode.

Individual Touchscreen Settings

Individual options are directed to the currently selected touchscreen
only. For example, when you choose Calibrate in the control panel,
only the current touchscreen is calibrated.

You use the Select Touchscreen option to make a touchscreen the
current touchscreen. This option is available in both the TouchWare
control panel and Microcal.

If you are calibrating multiple touchscreens for example, you must
select and calibrate each touchscreen.

How to Select a Touchscreen

To select a touchscreen to be the current touchscreen, use the Select
Touchscreen option. The system displays a monitor ID on each screen.
To select a touchscreen, touch the 1D number displayed on the desired
monitor. This touchscreen becomes the currently selected
touchscreen.
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You can identify the current touchscreen by its monitor ID number.
The TouchWare control panel and Microcal display the ID number of
the currently selected touchscreen at the bottom of the window.

Note: Although the cursor automatically follows your touch from
touch monitor to touch monitor, only one touchscreen is the currently
selected touchscreen. An individual setting is applied to the current
touchscreen only.

P To select a touchscreen:

1. Open the TouchWare control panel or Microcal. The Select
Touchscreen option in each is identical.

2. Choose Select Touchscreen. The following message box appears:

Microcal performs its operations on the currently selected
touchscreen.

When vou click Begin, the system will display an IDnumber on
all monitors.Touch the ID number of the screen yvou want to
select as the current touchscreen.

Cancel | I

3. Click Begin. Identification numbers appear on all monitors.

4. Touch the ID number on the touchscreen you want to select as the
current touchscreen.

The touchscreen mapped to monitor 2is now the
currently selected touchscreen.
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5. Click OK. The selection process is completed. Notice that the
Current Monitor ID status has been updated.

Note: It is possible for the TouchWare control panel and Microcal to
have different touchscreens selected. Always check the Current
Monitor ID number before choosing an option.

TouchWare Control Panel

When you use multiple touch monitors, the TouchWare control panel
has a Select Touchscreen option available. This option lets you select
a specific touchscreen to be the current touchscreen. The individual
settings are only applied to the current touchscreen.

0 =—-S=TouchWare =——"+1:=—H /_ A global setting is
Global Touchscreen Settings applied to all

Touch Faode Tap Speed t(_)uchscreens
simultaneously.

!:, Liftaff Slove !:l l:::l l:::l Fast
{:l Tap Tap Area

(3 Drag Large 8 O3 (0 Sroall

[  WVertical Offset |

/— An individual setting
is applied to the
Individual Touchsereen Settings current touchscreen
only.

[Calihrate] [ Reset ]

[ Show Monitor IDs ]

[ Map Touchscreens ]

[Select Touchscreen | Use this option to
select a touchscreen
| Monitor 1D of Current Touchscreen: 2 | to be the current

touchscreen.
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Microcal

All Microcal options are applied to the current touchscreen only. Use
the Select Touchscreen option to specify a touchscreen to be the

current touchscreen.
_ _ [0 =———Mitcrnical=———-—H
Use this option to
select a touchscreen e
to be the current gﬂ Select Touchscreen i # Linearize
touchscreen it
Eﬂ- Draw Show Monitor 1Ds
N
: :| Calibrate Map Touchscreens
A
Adjust Frequency Quit

Current Touchscreen Status

Identifies the current

touchscreen Output Identity: UL.2.0 Capacitive

Monitor 1D: 1
Touchscreen communicating.
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Troubleshooting

This chapter provides tips and strategies for solving problems you
may encounter with the touchscreen either during installation or
normal use.

MicroTouch is committed to helping you get the most from your
touchscreen. MicroTouch provides extensive technical support
through our help desk and web site. For more information on
technical support, refer to the “About This Manual”” section at the
beginning of this document.
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Troubleshooting Common Problems

Problem:

Problem:

Problem:

Cannot activate items by tapping the touchscreen.

The tap speed and tap area define the conditions that must exist for
the system to interpret your touches as a double-click or drag. Use the
TouchWare control panel to adjust the tap speed and tap area. If you
tap slowly, be sure to set the speed to slow in order for the second tap
to register with the system. For more information on making these
adjustments, refer to Chapter 3.

Requires pressing hard on the touchscreen to register atouch or to
drag the cursor.

When operating normally, the touchscreen requires a light touch to
respond. If you find that a firm or hard touch is required, the current
operating frequency is probably being interfered with.

To correct this problem, run Microcal and select the Adjust Frequency
option. Change the operating frequency of the touchscreen as many
times as necessary until you find a frequency that allows a light touch
to be recognized (see “Problem: Cursor is jittery”).

For more information on making these adjustments, refer to Chapter
4,

Cannot move the cursor to the edges of the screen.

The touchscreen is not properly aligned with the underlying video.
You need to re-calibrate the touchscreen. For more information on
how to calibrate the touchscreen, refer to Chapter 3.

When calibrating the screen, be sure you touch the center of each
target firmly and precisely. Use the Microcal Draw program to check
for proper touchscreen operation.

Note: You can touch the screen and then drag your finger to the center
of the target. The system does not register the touch point until you lift
your finger off the screen. Once you position your finger, be sure to
hold the touch for at least three seconds.
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Problem:

Problem:

Problem:

Problem:

Cursor is jumpy or takes sudden bounces across the screen.

The touchscreen is receiving more than one touch at the same time.
When you touch the screen, be sure to point and touch with one finger
only. Keep your other fingers away from the touchscreen.

If more than one finger touches the screen, the cursor jJumps from one
location to the next. In the case of two fingers touching, the cursor
moves to a spot halfway between the two touch points. Touch only
one location at a time.

Cursor is jittery.
The touchscreen is receiving too much interference from the monitor.
You need to adjust the operating frequency of the touchscreen.

Run Microcal and use the Adjust Frequency option to change the
frequency. Test touchscreen operation after each frequency change
with the Draw program. Generally, use the highest setting that
produces the smoothest lines and provides best overall operation.

Lines are not straight and smooth.
Could be one of the following problems:

* You need to adjust the operating frequency of the touchscreen.
Run Microcal and use the Adjust Frequency option to change the
frequency. Select a new frequency and test it with the Draw
program. Generally, use the highest setting that produces the
smoothest lines and provides best overall operation.

* The touchscreen is not linear. Run Microcal and use the Linearize
option to perform a 25-point linearization.

The Linearize option in Microcal does not work.

Only the USB/SMT touchscreen controller supports 25-point
linearization. Older Macintosh touchscreen controllers do not support
linearization.
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Troubleshooting Multiple Touchscreens

Problem:

Problem:

Problem:

Problem:

Problem:

Problem:

Touch one screen, but the cursor appears on another screen.

Your touchscreen controller does not support multiple touchscreens.
Only USB touchscreen controllers with an Output Identity of U1.2.0
or newer support multiple touchscreens.

If your controllers have an Output Identity of U1.2.0 or newer, then
there is a device conflict on the USB. Shut down your Macintosh and
the restart you system to clear any bus contentions.

After a Reset, Frequency Adjust, or Restore Factory Defaults has been
executed, the touchscreens behave erratically.

The touchscreen controllers do not support multiple touchscreens.
Only USB touchscreen controllers with an Output Identity of U1.2.0
or newer support multiple touchscreens.

When configuring multiple monitors, the Arrange icon is missing.
Your system is configured with a single video port. Additional ports
are required for multiple monitor configurations. Refer to your
Macintosh documentation.

The TouchWare control panel appears on all my monitors.

Your system is configured for duplicate or mirrored monitors. Re-
configure your Macintosh and remove duplication by dragging the
screen icons apart. Refer to “Configuring the Macintosh Operating
System” in Chapter 5.

When mapping touchscreens, the system does not detect all
touchscreens.

Check that all your touchscreen cables are connected to the USB bus.
Verify that each controller is detecting touch by checking its LED.

Touch not recognized when mapping or selecting touchscreens.
The touchscreen is receiving too much interference. Use Microcal to
adjust the touchscreen operating frequency.
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Error Messages

Error:

Error:

Error:

This section lists the error messages that you may receive when
installing the touchscreen software, using the TouchWare control
panel, or running the Microcal Diagnostic utility.

Output status reported one or more of the following errors: ROM,
PWM, NOVRAM, and HDW.

This error indicates there is a problem with the hardware. Contact
MicroTouch Technical Support for help.

The control panel “TouchWare” cannot be used with this Macintosh.
The Macintosh cannot open the control panel because it does not
recognize or cannot find the touchscreen.

Several problems can produce this error message:

» The touchscreen cable is not connected to a USB port and the
USB manager cannot talk to it

* The touchscreen conflicts with another device in the USB chain.

To correct this error, remove and reinsert the USB connector from
each touchscreen, checking each time to see if the problem has
cleared up.

Touchscreen is not responding. Check connections.
The touchscreen cable is not properly connected to a USB port. Check
the cable connection, restart the Macintosh, and try again.
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Error: No touchscreen mapped. Monitor x does not have a touchscreen or the
touchscreen is not responding.

TouchWare has detected a monitor that is not identified as a
touchscreen.

This error can occur if

» The touchscreen cable is not connected to the USB port or is not
connected properly.

» The touchscreen controller is faulty.
* You pressed ESC during touchscreen mapping to indicate that this
monitor did not have a touchscreen attached.

Error: TouchWare (Microcal) has encountered an error mapping the
touchscreens.

TouchWare has detected a monitor that is not identified as a
touchscreen.

This error can occur if

» The touchscreen cable is not connected to the USB port or is not
connected properly.

» The touchscreen controller is faulty.

* You pressed ESC during touchscreen mapping to indicate that this
monitor did not have a touchscreen attached.
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Status Light on the Controller

Note: The status LED is visible only on touch monitors used with G3
systems. On iMac systems, this LED can be accessed only by a
qualified service person. For assistance, please call MicroTouch
Technical Support.

The touchscreen controller has a light-emitting diode (LED) built into
it. The LED provides valuable information about the status of the
touchscreen and controller.

If you are experiencing problems with the touchscreen, be sure to
check the LED. Refer to Table 4 for an explanation of a bright, dim,
and blinking LED.

Table 4. LED Status Information

Status of LED Meaning

Bright Indicates one of the following conditions:

« Power has been applied to the controller, but
communication with the controller has not been
started.

e Controller has been initialized.
e The sensor is being touched.

NOVRAM error
Analog error

4 flashes per 10 seconds
5 flashes per 10 seconds

Continuously Dim Indicates the sensor is not being touched.
Blinking Indicates the power-on self-test failed. Possible errors
are as follows:
1 flash per 10 seconds = RAM error
2 flashes per 10 seconds = ROM error
3 flashes per 10 seconds = A/D error
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Touchscreen Care and Cleaning
Touchscreen maintenance is minimal.

MicroTouch does, however, recommend that you periodically clean
the glass touchscreen surface.

» Use isopropyl alcohol, or a non-abrasive glass cleaner. Avoid
using cleaners other than glass cleaners. Do not use any
vinegar-based solutions.

* Apply the cleaner with a soft cloth. Avoid using gritty cloths.
» Always dampen the cloth and then clean the screen.

Always handle the touchscreen with care. Do not pull on or stress
cables.
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